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Before you begin 
 
Log on to Office Therapy with the Administrative ID and password or as a user that has Administrative rights. 
 
Gather Your Gateway Provider and Group Information 

Please have your Provider and Group Information available. This can be found on the Gateway EDI 
website at www.gatewayEDI.com Please have the Gateway Addendum handy.   

 
Find your taxonomy code 

A taxonomy code is 10 digit code required by Gateway EDI that identifies your specialty.  If you do not 
know your taxonomy code you may look one up at www.wpc-EDI.com/codes/taxonomy. 
 

 
 
Getting Started 
 
Once you have gathered the information, open Office Therapy and begin entering in the data. (DO NOT use any 
special characters in any of the fields; use only numbers and letters) 
 

1. From the File menu, click Administration  
 

2. Select Maintain Electronic Filing Information  
 

                
 
 
This will open the Electronic Filing Setup window.  
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Follow the numbered steps below to continue the setup in the Electronic Activation screen. 
 
3. Make sure the Use Gateway EDI Clearinghouse box is checked. By checking this box it will 

automatically add the Receiver Company Info at the bottom of this screen. 
 

4. Make sure the Active option is selected and the Type is set to 837.  
 

5. Test Mode: If the NSF\837 Test Mode is checked the claims will NOT finalize. This is useful when you 
are in the testing stage with Gateway. 

→ Finalizing claims - when claims are processed using 'produce new claims' in the billing wizard, on 
a billing cycle, a question will be asked "Was the printing/filing of the HCFA claims successful".  If you 
click "yes" the claims will be finalized and there will be no way to re-produce the BATCH.  If you click "No" 
then claims will NOT be finalized, issues can be addressed and then the batch CAN be re-produced.  
However, when Office Therapy is set up in TEST MODE, this message will not appear and no claims will 
be finalized.   
Exception - If any provider or Ins. co is still set to file paper claims, this message will appear and 
selecting yes or no does not matter, these claims will NOT be finalized. 
 

6. No ISA or GS Header Information needs to be entered or modified to file claims to Gateway EDI. For 
more information about ISA and GS headers log on to: 
https://www.gatewayedi.com/gedi/docs/HipaaCompanionDoc.pdf 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. The Export folder for NSF/837 is the location where the batch or single claim file will be output.  This is 
the path you will specify to Gateway so that they can retrieve the claim file.  This default location is 
dependant on the Operating System you have installed on the computer. 

Windows 7 is - C:\Users\Public\Documents\Docutrac\Office Therapy\Data 
Vista Default is -  C:\Users\Public\Documents\Docutrac\Office Therapy\Data 
XP Default is -  C:\Documents and Settings\All Users\Documents\Docutrac\Office Therapy\Data 

8. If Office Therapy is in a network environment it may be necessary to use the Browse button  to 
navigate to a different location. 
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9. In this section, Submitter ID is required.  It is supplied to you by Gateway. It will be 4 characters and will 
also be the User ID Logon for the Gateway EDI website. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. These fields contain the technical contact information of the person filing claims. For Contact # and Type 
use the telephone number. 
 
 
 
 
Providers Filing Electronically  
 
 
 
11. Click the Providers 
Filing Electronically Tab 
 
 
 

  
12.  Select the providers you want included 
in the E- filing process. 
 
You can elect to move ALL from Excluded 
to Included and visa versa by clicking a 

double arrow.   
 
Or move a SINGLE choice by clicking to 
highlight then clicking a single arrow. 
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Insurance Companies Filing electronically 
 
 

 
13. Click the Insurance 

Companies Filing 
Electronically Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

14. Choose the Insurance Companies you want to be included in the filing process. 
 
You can elect to move ALL from Excluded to Included and visa versa by clicking a double arrow. 
 
Or move a SINGLE choice by clicking to highlight then clicking a single arrow. 
 

15. Convert all included companies to produce:  From the drop down pick list, select NSF/837 Format. 
 

16. IMPORTANT: Click on the Convert Format button to convert and save the file format. The claim files that 
are generated for the insurance companies listed under Companies Included will now be created using 
the 837 electronic format. 
 

17.  Click OK to save your settings.  
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Company Information 
 

                           
             

1. From the File menu, click Administration.  
 

2. Select Maintain Company Information.  
 
 
 
 
 
 
 

3. Fill out the 
information with 
your company 
name, address, 
phone and fax 
numbers, and 
tax ID. 
 
 
 
 
 
 
 

 
 

4. Leave Use Company information for the 837 Pay To Address unchecked. 
 

→ DO NOT FILL OUT BILLING SERVICE TAB UNLESS YOU ARE SOLELY A BILLING SERVICE. 
 

5. Click OK. 
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Provider Setup 
 

1. From the View menu, click Providers.  
 

2. Double click on a Provider’s name in the list to open the Provider setup window, assuming that the 
information for the provider you are activating for electronic filing has been previously entered. 
 

 
 

3. In the Provider setup window, click the E-File tab. 
 

4. Check the box, Activate Electronic insurance filing for this provider?. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Scroll down through the fields to find Specialty, and then enter the Taxonomy Code. 
 
Taxonomy Code: A taxonomy code is 10 digit code required by Gateway EDI that identifies your 
specialty.  If you do not have a taxonomy code you can get information at  
www.wpc-EDI.com/codes/taxonomy  This is a Web site with more information on how to obtain a 
taxonomy code. 
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6. Click on the HCFA Details Tab. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
7. Enter the following 

information:  
 

25. Enter either a SSN or an EIN (Tax ID) number. 
    

Select the option for EIN. 
    

24J.This is for the New Individual National Provider Identifier assigned to the provider. 
    

33a.This is for the New Organizational NPI assigned to the facility. This must be different from 24J. If you 
don’t have an Organizational NPI, leave blank. 
    

31. The Physician or Supplier. (Signature). 
    

33. This is the billing information for the Provider. 
 

8. 33. (PIN #).  Click Add - This is a field for the secondary Id that may be assigned by an insurance 
company.  Also known as the Rendering or Legacy number.  
Note: Most Insurance Companies are no longer using the Rendering/Legacy number. If you are unsure of 
whether to enter this number or not, contact Gateway or contact the specific Insurance Company to find 
out if they are identifying the provider by the NPI # and the tax ID. 
 

9. Choose Insurance Company from the 
pick list. This assumes that you have 
entered your insurance companies into 
the system. 

  

Enter an Id, and choose a Type from the 
pick list. 

  
For Gateway EDI you must select NO 
from the pick list for Rendering Provider 
is the same as the Pay to Billing Provider 
when filing the 837 Format. 

  
 
 

10. Click OK. Then click OK again on the Provider setup window. 
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Insurance Company Setup 

 
From the View menu, click Insurance Companies. Then double click on an Insurance Company’s name in 
the list to open the setup window. 
 

 
1. In the setup window, 

click on the HCFA 
Details Tab. 
 

2. Box 1: If applicable, 
choose the Insurance 
Type from the drop 
down pick list. 
 

3. Box 33 Grp.#  If a 
Group number is 
located under the GRP 
column on the 
Gateway Addendum 
enter it in the 
Insurance Id field. 
 

 
Select an ID Type from 
the drop down pick list. 

Gateway requires you choose from one of the following five: 1A-1B-1C-1D or G2. 
If filing claims with an Organizational NPI number, enter the tax ID and select EI for ID Type. 
 
 

4. Click the E-File tab. 
 
  
  

5. Check the box for Activate 
Electronic insurance filing? for 
this Insurance Company. It 
may already be checked.   

 
6. For Electronic Filing Format, 

select NSF/837 from the pick 
list. 

  
  
  
  
  
  
 

7. The National Payer ID is a 5 - 7 digit number. (Please Refer to the Gateway Addendum). 
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8. 837 – Use Prov Addr (Y or blank) and Set 2010AA to Individual: 
 
If you are part of a Group and you have a group number on the Insurance Company/ HCFA details tab/ 
Box 33 – Group #, put a Y in the value for Use Prov Addr & 837. 
 
If you are an Individual, put a Y in the value for 837 – Set 2010AA to Individual. 
 
NOTE: Entering a Y in the correct area ensures that the Individual and Organizational NPI numbers show 
up in the correct loop and segment on the claim.  If you have an Org NPI or Grp. Number, chances are 
you are set up as a group and must enter the letter Y in the 837-Use Prov Addr field. 
 
Anytime a provider is filing under the Organization NPI enter the letter Y in the 837-Use Prov Addr field. 
 

9. Does Not Support NPI (Y or blank) – Enter a Y here and neither the Individual nor Organizational NPI 
will populate in the electronic claim file. 
 

10.  Click OK to save. 
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Client Setup 
 
Under the View menu, click Clients. In the Clients window double click on a client’s name in the list to open the 
Client Setup window. 
 
 

1. Click on the Insurance tab.  This screen will default to the Primary Insurance, assuming that you have 
already entered the insurance information for the client.  Click Secondary in the Policy Explorer for a 
client's Secondary Insurance.  All fields for primary that our required are also required for secondary. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

2. Make sure File Claims is checked. 
 

3. Gateway EDI requires values in the Claim Filing Ind. and the Insr. Type. 
 
Claim Filing Indicator – Use one of these four options: BL, CI, MB or MC only. 
Insur. Type – Use one of these three options: C1, MB or MC only. 
 
 

4. Click the HCFA/837 Details…button. 
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5. Box 17. Enter Referring Physician Information. If the NPI is required, enter it in 

the field labeled ID and choose National Prov ID from the pick list in the ID Type field. 
 

6. Box 14. This field is required. Make sure the Date of Current Illness is ON or BEFORE the first date of 
service. 
 

7. Box 32. Either fill in the Facility Name and Address, or make sure that the Copy HCFA Box #33 is 
checked.  If you are filing with an Organization NPI number you will have to type in the address where the 
service was rendered for each client.   
Correct Format Example:  
                                         Name of facility 
                                         Address 1 
                                         Address 2 
                                         City, ST 00000 
 

8. 32a and 32b are listed for facility NPI numbers; however, some Insurance Companies may require these 
fields to be populated.  If you are filing with an Organization NPI enter it in box 32a. 
 

9. Complete any other information the Insurance Company may require. Then click OK to save. 
 
 
. 
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Provisions 
 
 
DocuTrac Inc. has provided this guide to you based upon required information from Gateway EDI and the ANSI 
837 X12 Implementation Guide.  Please use this Office Therapy guide to assist you in setting up the program to 
generate electronic claim files.   
Acceptance of claims through Gateway EDI and the Insurance Company is dependant upon valid data entered 
into the program.  This guide only reflects required fields of the most standard version of an electronic claim form.  
  
Following the steps in the guide will increase the likelihood of a successful first time test with Gateway EDI and 
expedite that process.  Following the steps in this guide will not guarantee claims to be accepted or paid. 
 
To learn about the ANSI 837 X12 Implementation: 
 

http://www.nahdo.org/project/837101Tutorial.htm 
 
http://www.cms.hhs.gov/MLNMattersArticles/downloads/MM5334.pdf 

 
 
 
 
Creating a Test Batch - PLEASE READ ALL INSTRUCTIONS FIRST 
 
It will be to your benefit to have a full understanding of the billing cycle, Test Mode and finalizing claims in Office 
Therapy BEFORE you create a test file.  Please contact DocuTrac Technical Support to schedule a time for 
creating and managing your claim files. 

 
Click the File Insurance icon in the left menu bar.   

 
 
 
 
 
Use the first selection of Submit new 
charges to primary insurance companies’ 
and click on Next.  (This will generate a 
batch of claims for ALL Open Charges in 
the program) 
 
 
 
 
 
 
 
 
 

To submit charges for one client at a time, please use Re-submit charges for one Client option. This option will 
NOT finalize a charge in the ledger’s FILE column. 
 
Follow the instructions on each page of the Insurance Filing Expert. Then click Finish. 
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Once the 837 file is created an Electronic Claims Log will be displayed. 
 
Be sure to make note of the location in the line 837 Claim File to…  This will tell you where on the computer the 
file you have created can be found in order to upload it to Gateway EDI. This is the same path that can be found 
on the Maintain Electronic Filing Information screen. 
 
 
 
837 Errors: If there are errors in the creation of the 837 you will be prompted by a message window. You will 
need to correct these errors and regenerate the claim. The errors and error locations can be viewed on the 
Electronic Claims Log. 
 
 
  
  
  
 
 
 
  
 
 
 
 
 
 
 
 
 
 
  
  
  
  
  
 
 
 
It is suggested to print this out – This is the only record with the client information and the file name. 
 
 
Please see page 2, item number 5 of this guide for Test Mode. 
 
 
 
File Name: All claim files end with .837.  The file name is the 2 digit year, 2 digit month, and 2 digit day, followed 
by 2 digits for the series.  Example (10122000.837 is December 20, 2010 and the first claim created that day.  
The next claim on the same day would be 1022001.837) 
 
 
 
 
 



DocuTrac’s Office Therapy™ 
Electronic Claims Setup Using (837 ANSIX12 ONLY) For Gateway EDI 

 

 14 

Contacting Gateway EDI  
 
Prior to your test date with Gateway, make sure you have completed the set up with the 
assistance of a DocuTrac Technical Support Representative. 
 
 
You are now ready to upload your test file to Gateway EDI.  Please contact a Gateway Representative for 
instruction on how to transmit the file. 
 
 
Obtain Provider Information 
 
 

  
 
 
Open your web browser and direct it to www.gatewayedi.com 
 
Enter your Gateway EDI user name and password. If you do not have one, please call Gateway EDI at  
1-800-556-2231. 
 
 
Rest your mouse on My account to view a pop up menu. Select Manage Providers. Then select View Provider 
Details and Enrollment Status. 
 
Click on a provider name, and a document will appear with provider, payer and grp. Numbers that you will need to 
enter in the Office Therapy Program.  
 

  You can print this out or view it in excel by selecting one of the icons on the top of the page. 
 
 
 
 

Office Therapy is a registered trademark of DocuTrac Inc. Copyright © 2006-2011. All Rights Reserved. 
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